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Documentation at HSC: http://herschel.esac.esa.int/Documentation.shtml

• HSpot User’s guide:
http://herschel.esac.esa.int/Docs/HSPOT/html/hspot-help.html

• PACS observer’s manual:
http://herschel.esac.esa.int/Docs/PACS/html/pacs_om.html
http://herschel.esac.esa.int/Docs/PMODE/html/parallel_om.html

• Herschel Observer’s manual:
http://herschel.esac.esa.int/Docs/Herschel/html/observatory.html

• AOT release notes :
http://herschel.esac.esa.int/AOTsReleaseStatus.shtml

• Herschel Reserved Observation Search Tool:
http://herschel.esac.esa.int/Tools.shtml#HROST

NHSC website:    https://nhscsci.ipac.caltech.edu/sc/
• Documentation Page: 

https://nhscsci.ipac.caltech.edu/sc/index.php/Pacs/HomePage
• Open Time 1 Proposals Page:

https://nhscsci.ipac.caltech.edu/sc/index.php/Proposals/Proposals

Preliminary remarks and Useful Links

Bruno Altieri - Nicolas BILLOT – HSC – June 2010
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HSpot User’s Manual: 
“HSpot is remarkably simple and a user-friendly piece of software.”

Enable automatic update feature under the “Options” menu on the HSpot toolbar.
Need version 5.0.x for current AO.
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1. Provide Target Information

2. Select the Instrument Settings (band, gain)

3. Select the Observing Mode and Setup Observational Parameters to 
Suit your Scientific Goal 

4. Check AOR with Visualization Tools, Check Sensitivity Estimates

5. Concatenate/Chain AORs Together to Build your Observation

Planning an Observation with HSpot

You will need the exact proposal name, e.g. KPGT_aabergel_1, 
that you can find at http://herschel.esac.esa.int/Key_Programmes.shtml

For comparison, or inspiration:
You can view accepted observing proposals + AORs:
“View Accepted Proposals” under the “File” menu
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Scan-Map of a Galactic 
Star-Forming Region

Point-Source Observation
(Mini-Scan Map and Chop/Nod)

Two Science Cases to illustrate 2 AOTs

Only two observing modes survived the Performance Verification Phase:
(Small-Source AOT and Raster Map AOT decommissioned)

Scan Map and Chop/Nod
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Define a Target or Target List

New Target Target List

• Fixed or Moving Targets

• Resolve the Name

• Target Visibility

• Background 
at given time, coordinate, and wavelength
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“PACS Photometer…” under the “Observation” menu

70 and 160 μm
OR

100 and 160 μm

Target information

Unique AOR Label

# stars in Star Tracker 
(better be >9)

Target and Instrument settings
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70 and 160 μm
OR

100 and 160 μm

Target information

Unique AOR Label

# stars in Star Tracker 
(better be >9)

Source Estimates:
Saturation limits drive 
the change of readout 

electronics gain.
Low-gain setting 

reduces sensitivity.
Saturation limits are 

very conservative.

“PACS Photometer…” under the “Observation” menu

Target and Instrument settings

Nicolas BILLOT – NHSC – June 2010
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Gain Setting
Target and Instrument settings

WARNING: if you fool HSpot gain setting by putting in lower 
flux estimates, then SNR estimates become irrelevant!

Full dynamic range

intrinsic pixel-to-pixel dispersion

Room left to accommodate the signal

• HSpot saturation limits are very conservative, they assume the 
peak of the PSF sits on the brightest pixel.

• Low-gain setting reduces the sensitivity (higher digitization noise).

• We recommend to switch to low-gain setting only if source flux 
significantly exceeds the official saturation limits.

• If source flux marginally above saturation limit, put in a lower flux 
to fool HSpot and avoid switching to low-gain setting.

See PACS Key Information on NHSC website: https://nhscsci.ipac.caltech.edu/sc/index.php/Pacs/InstrumentDetails
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Scan Map AOT Settings
User input parameters for Scan Maps:

• Filter
• Scan Speed
• Scan Leg Length
• Cross-scan Distance
• Number of Scan Legs
• Square Map
• Homogeneous Coverage
• Orientation Reference Frame
• Orientation Angle
• Orientation Constraint
• Repetition Factor
• Source Flux Estimates (optional)
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Scan Map AOT Settings

User input parameters for Scan Maps:
• Filter
• Scan Speed
• Scan Leg Length
• Cross-scan Distance 
• Number of Scan Legs
• Square Map 
• Homogeneous Coverage
• Orientation Reference Frame
• Orientation Angle
• Orientation Constraint
• Repetition Factor
• Source Flux Estimates (optional)

Choice of Scan Speed:

• Medium or Standard (20’’/s) for optimum modulation 
of the signal from the telescope motion (in terms of 1/f 
noise).

• Fast (60’’/s) for large maps at the expense of 
degraded PSFs (10% - 60% elongation in scan 
direction) and longer overheads due to longer turnover 
time.
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Scan Map AOT Settings

User input parameters for Scan Maps:
• Filter
• Scan Speed
• Scan Leg Length
• Cross-scan Distance 
• Number of Scan Legs
• Square Map 
• Homogeneous Coverage
• Orientation Reference Frame
• Orientation Angle
• Orientation Constraint
• Repetition Factor
• Source Flux Estimates (optional)

Choice of Map Size Parameters:

• Scan leg length sets dimension of one map side (< 20°).

• Use Homogeneous Coverage for large maps
(Cross-scan distance is set automatically).

• Square Map makes observation scheduling easier
(number of scan legs is set automatically).

• Cross-scan distance <105’’ ensures overlapping 
between scan legs for all array-to-map angles (in sky 
coordinates).

• Cross-scan distance of 51’’ (~sub-array size) gives 
relatively flat exposure maps in Sky coordinates, whatever 
the array-to-map angle.
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Scan Map AOT Settings

User input parameters for Scan Maps:
• Filter
• Scan Speed
• Scan Leg Length
• Cross-scan Distance 
• Number of Scan Legs
• Square Map 
• Homogeneous Coverage
• Orientation Reference Frame
• Orientation Angle
• Orientation Constraint
• Repetition Factor
• Source Flux Estimates (optional)

Choice of Repetition Factor:

• This sets the sensitivity of the observation once the 
other parameters are set. 

• If repetition factor >1, it is recommended to use an 
even number of scan legs to minimize satellite slew 
overheads.

• The repetition factor also offers flexibility when 
combined with other parameters, e.g. 1 repeat slow 
scan or 3 repeats fast scans.
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Scan Map AOT Settings

User input parameters for Scan Maps:
• Filter
• Scan Speed
• Scan Leg Length
• Cross-scan Distance 
• Number of Scan Legs
• Square Map 
• Homogeneous Coverage
• Orientation Reference Frame
• Orientation Angle
• Orientation Constraint
• Repetition Factor
• Source Flux Estimates (optional)

Choice of Map Orientation Parameters:

• No magic angle like SPIRE (focal plane filled with bare pixels).

• Absolute flexibility: all scan directions are possible in array or 
sky reference frame, with optional constraints.

• BUT think twice before putting a constraint to your 
observation: Orientation constraints translates into scheduling 
constraints, hence in observing time penalties.

• Avoid scanning at array angles of 0° and 90° because of 
empty inter-module gaps.

• If scan maps in Sky coordinates without array constraints, the 
map coverage depends on the exact observation date, and 
there is a risk that the array-to-map angle is 0° or 90°. Check 
the AOR overlay on image at given visibility windows.
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Orientation Angle Reference Frame Options:
Sky
Array
Sky with Array Constraint
Array with Sky Constraint

Scan Map AOT Settings

WARNING: 
10 MINUTES PENALTY FOR CONSTRAINT

600s penalty
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AOR Performance Estimate

Details of AOR execution time

Sensitivity estimates

Confusion noise estimates

More details here

only for mini-scan map mode
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PACS Time Estimator Message

The final sensitivity of your observation depends 
to some extend on the data reduction, e.g. 
highpass filtering, MADMap, source registering 
to correct for pointing errors, etc.

Map geometrical parameters summary

Total AOR duration

Average pixel exposure time
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Check your observation
Always visualize your observations and check the coverage maps.

Check map orientation in chosen visibility 
window.

Check coverage homogeneity (exposure 
time per pixel in seconds).

If scan map in sky coordinates, check that 
the array-to-map angle is not 0° or 90°.
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Scheduling Constraints
“Group/Follow-on Constraints…” under the “Tools” menu
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Timing constraint: 
AOR executed within specified time period (ABSOLUTE TIME, BEFORE or AFTER), e.g. 
period when moving target is out of Galactic Plane.

Grouping/Follow-on constraint:
• Sequence: 

sequence of AORs executed in specified order within a given period of time.
• Chain or Concatenation: 

AORs are executed in the order specified with NO interruption in the chain, e.g. 
scan and X-scans, or PACS 3-band observations.

• Group within: 
AORs executed within a given period of time but in any order.

• Follow-on: 
AORs observed in sequence at given intervals of time, appropriate for observation 
of variable targets, e.g. YSOVAR-like programs.

Scheduling Constraints

600s overheads instead of 180s

Spare Observatory slew time (180s – CalBlock duration)

600s overheads instead of 180s

600s overheads instead of 180s

600s overheads instead of 180s
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Science-driven Parameter Choices
for a Scan Map of a Star-forming Region

Safe choices for observing a star-forming region:
• 20’’/s (or 60’’/s or SPIRE/PACS Parallel mode if PSF quality not critical)

• Homogeneous coverage

• Square map

• Instrument reference frame is ARRAY, with array-to-map angle of 45°
• Concatenate X-scan with orientation angle of 135° (spare 2 minutes slew time)

Map-making algorithms require the highest pixel and scan-direction redundancies possible, so that 
scan and X-scan observations are highly recommended to preserve the extended emission, i.e. 
separate 1/f noise from large scale structures in the data processing.

• Possibly Concatenate pairs of scan/X-scan AORs to observe in 3 bands, 
i.e. observing at 70/160 μm AND right after at 100/160 μm (spare another 2 minutes slew time)
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Science-driven Parameter Choices
Other Tips and Tricks

Scenarios that give same sensitivity in final map:
• 1 Scan at 20’’/s versus 3 Scans at 60’’/s :

AOR execution time is significantly higher in case of fast scan due to longer turnover times 
between scan legs. It is prohibitive for small maps.

overhead60’’/s >> overhead20’’/s

• 1 fine Scan (short cross-scan distance) versus 3 loose Scans (larger cross-scan distance) 
while covering the same area (it requires to un-tick homogeneous coverage) :

AOR execution time is similar, but fine scanning gives more homogeneous coverage.

For deep scan maps and best PSF reconstruction:
• Instead of multiple repeats at the same location, one should 

• decrease the cross-scan distance between legs to increase spatial redundancy within a 
single map. 

• dither the entire map by shifting slightly the center of the map, and concatenate pairs of 
scan/X-scan AORs.
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Chop/Nod point-sourceMini-scan Map

Advantages for source fluxes in range (50mJy-50Jy):
• Stability of reconstructed PSF (RPE<0.3’’)
• High spatial resolution
• High photometric accuracy for isolated sources
• Actual sensitivity worse than HSpot numbers
• Rely on very few pixels
• Positive-negative beams in final image:

Limitations due to crowded backgrounds
Limited area of homogeneous coverage

• Better characterization of target close vicinity 
• Better characterization of larger scale structures
• Larger area of homogeneous coverage
• High redundancy as more pixels see the source
• Better sensitivity (efficient high-pass filtering)
• No negative beams in the map
• OK for targets with large positional uncertainty
• Relatively large overheads (still more sensitive!)

Point Source Observations
2 Options

Detailed comparison in AOT release note: 
http://herschel.esac.esa.int/Docs/AOTsReleaseStatus/PACS_PhotChopNod_ReleaseNote_22Feb2010.pdf
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Point Source Observations
Chop/Nod mode

User input parameters for Chop/Nods:
• Filter
• Dithering
• Chopper avoidance angle
• Repetition Factor
• Source Flux Estimates (optional)
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Dither is recommended for faint sources:
• 3-position dither along Y-axis of spacecraft using the chopper with 8.5’’ throw
• Possible dither along Z-axis by concatenating AORs with slightly shifted target 
positions (spacecraft dithering rather than chopper dithering) 
• Check AOR overlays and coverage maps

Chopper avoidance angle:
• Penalty of 600 seconds for scheduling constraint
• Constraint not fed back in HSpot visibility window

Repetition factor:
Number of AB nod cycles to reach required sensitivity

Point Source Observations
Chop/Nod mode
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Recommended parameters that make mini-scan maps the least inefficient possible in 
terms of overheads and idle-times:

• 20’’/s scan speed
• Scan along the diagonal of the array, i.e. at 70° and/or 110° in array coordinates
• Concatenate X-scan map at 110°or 70°

Allows various kinds of mapmaking techniques, and provide higher quality photometry and better 
spatial characterization of the near source vicinity

• NO homogeneous coverage, and NO square map
• 10 scan legs with cross-scan distance of 4’’

For shallow observations: less legs (but even number to minimize satellite movement) with larger cross-
scan distances or skip cross-scan direction

• Scan leg length from 2’ to 4’:
3’ length: optimal usage of constant scan speed of 20’’/s, but during idle-positions the source is 
outside the array
2’ length: Source is always on-array, but acceleration/deceleration of source on array might require 
more elaborated processing

• Repetition factor: as needed to reach the required sensitivity

Point Source Observations
Mini-Scan Map

Same Template as the large scan map example presented previously.
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HSC website:    http://herschel.esac.esa.int/esupport/
• Where to find this presentation

Questions?


